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ETAS Über dieses Dokument
1 Über dieses Dokument
Dieses Dokument richtet sich an Fachpersonal in den Bereichen Entwicklung 
und Test von Kfz-Steuergeräten. Fachwissen im Bereich Mess- und Steuer-
gerätetechnik wird vorausgesetzt.

Dieses Dokument enthält Informationen zum Einstieg in die Arbeit mit LABCAR-
OPERATOR V5.4.13.

Das Handbuch besteht aus folgenden Kapiteln:

• “Über dieses Dokument” auf Seite 5

Dieses Kapitel
• “LABCAR-OPERATOR – Eine Übersicht” auf Seite 9

In diesem Kapitel erhalten Sie einen Überblick über die Anforderungen an 
Testsysteme für Controller im Automotive-Bereich und die daraus fol-
gende Architektur von LABCAR-OPERATOR und dessen Komponenten.

• “Installation” auf Seite 21

Dieses Kapitel enthält Informationen über Lieferumfang, Hard- und 
Softwarevoraussetzungen für die Installation und die Vorbereitung der 
Installation.

• “Tutorial” auf Seite 33

In diesem Kapitel wird anhand eines einfachen Beispiels beschrieben, 
wie Sie ein LABCAR-OPERATOR Projekt erstellen und mit diesem arbei-
ten.

• “ETAS Network Manager” auf Seite 68

Dieses Kapitel beschreibt den ETAS Network Manager, der Sie bei der 
Adressierung der ETAS-Hardware in Ihrem Netzwerk unterstützt.
LABCAR-OPERATOR V5.4.13 - Schnelleinstieg 5
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1.1 Klassifizierung von Warnhinweisen
Die hier verwendeten Warnhinweise warnen vor Gefahren, die zu Personen- 
oder Sachschäden führen können:

1.2 Darstellung von Handlungsanweisungen
Das zu erreichende Ziel wird in der Überschrift definiert. Die dafür notwendigen 
Handlungsschritte werden in einer Schritt-für-Schritt-Anleitung aufgeführt:

Zieldefinition
1. Schritt 1

2. Schritt 2

3. Schritt 3

> Resultat

GEFAHR
kennzeichnet eine gefährliche Situation mit hohem Risiko, die zum Tod oder 
zu schweren Verletzungen führt, wenn sie nicht vermieden wird.

WARNUNG
kennzeichnet eine gefährliche Situation mit mittlerem Risiko, die zum Tod 
oder zu schweren Verletzungen führen kann, wenn sie nicht vermieden wird.

VORSICHT
kennzeichnet eine gefährliche Situation mit geringem Risiko, die zu leichten 
oder mittelschweren Verletzungen führen kann, wenn sie nicht vermieden 
wird.

HINWEIS
kennzeichnet eine Situation, die zu Sachschäden führen kann, wenn sie nicht 
vermieden wird.
LABCAR-OPERATOR V5.4.13 - Schnelleinstieg 6
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1.3 Typografische Konventionen

Software

1.4 Darstellung unterstützender Informationen

1.5 Datenschutzhinweise

1.5.1 Datenverarbeitung des LABCAR-OPERATOR V5.4.13
Bitte beachten Sie, dass bei Nutzung des vorliegenden Produkts LABCAR-OPE-
RATOR V5.4.13 personenbezogene Daten verarbeitet werden.

Die ETAS GmbH haftet nicht als Hersteller für etwaiges Fehlverhalten im 
Umgang mit diesen Daten.

OCI_CANTxMessage msg0 = Code-Ausschnitte werden in der Schriftart 
Courier dargestellt.
Die Bedeutung und Verwendung von Befeh-
len erfolgen durch die Erklärungen in den 
Kommentaren. Die Kommentare werden 
dabei in der entsprechenden Syntax darge-
stellt.

Wählen Sie Datei → Öffnen. Menübefehle werden fett dargestellt.
Klicken Sie OK. Schaltflächen werden fett dargestellt.
Drücken Sie <EINGABE>. Tastaturbefehle werden in spitzen Klam-

mern, in Kapitälchen dargestellt.
Das Dialogfenster „Datei öff-
nen“ erscheint.

Namen von Programmfenstern, Dialogfens-
tern, Feldern u.ä. werden in Anführungszei-
chen gesetzt.

Wählen Sie die Datei 
setup.exe aus.

Text in Auswahllisten, Programmcode sowie 
Pfad- und Dateinamen werden in der Schrift-
art Courier dargestellt.

Eine Konvertierung zwischen 
den Datentypen logisch und 
arithmetisch ist nicht möglich.

Inhaltliche Hervorhebungen und neu einge-
führte Begriffe werden kursiv gesetzt.

INFO
Beinhaltet zusätzliche unterstützende Informationen.

INFO
Der Erwerber des LABCAR-OPERATOR V5.4.13 ist gemäß Art. 4 Nr. 7 der
Datenschutzgrundverordnung (DSGVO) für die rechtskonforme Verarbeitung
der Daten verantwortlich.
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1.5.2 Daten und Datenkategorien
Bei Verwendung des ETAS License Managers in Kombination mit User-based 
Licenses werden insbesondere folgende personenbezogene Daten oder Daten-
kategorien zu Zwecken der Lizenzverwaltung erfasst:

Kommunikationsdaten: IP-Adresse
Benutzerdaten: UserID

1.5.3 Technische und organisatorische Maßnahmen
Das vorliegende Produkt LABCAR-OPERATOR V5.4.13 führt keine Verschlüsse-
lung der erfassten personenbezogenen Daten durch.

Bitte stellen Sie die Datensicherheit der aufgezeichneten Daten durch geeig-
nete technische oder organisatorische Maßnahmen ihres IT-Systems sicher, 
z.B. durch klassischen Diebstahl- und Zugangsschutz auf die Hardware.

1.6 Die Handbücher zu LABCAR-OPERATOR V5.4.13
Folgende Handbücher zu LABCAR-OPERATOR V5.4.13 sind erhältlich:

• LABCAR-OPERATOR V5.4.13 - Schnelleinstieg

Dieses Handbuch
• LABCAR-OPERATOR V5.4.13 - Benutzerhandbuch 

In diesem Handbuch finden Sie eine vollständige Beschreibung aller 
Funktionen von LABCAR-OPERATOR V5.4.13 und Sie erhalten Anleitun-
gen zur Bedienung dieser Funktionen. 

• LABCAR-RTC V5.4.13 - Benutzerhandbuch 

In diesem Handbuch wird Erstellung und Parametrisierung von Hard-
warekonfigurationen für HiL-Testsysteme beschrieben.

Die Handbücher befinden sich als PDF-Dateien auf Ihrer Installations-DVD und 
sind zudem über das Menü Help zugänglich. Über den Index, Volltextsuche und 
Hypertextlinks sind relevante Stellen schnell und komfortabel zu finden. 
LABCAR-OPERATOR V5.4.13 - Schnelleinstieg 8
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2 LABCAR-OPERATOR – Eine Übersicht
In diesem Kapitel erhalten Sie einen Überblick über die Anforderungen an Test-
systeme für Controller im Automotive-Bereich und die daraus folgende Archi-
tektur von LABCAR-OPERATOR und dessen Komponenten.

2.1 Anforderungen an das Testsystem
Dieser Abschnitt beschäftigt sich mit den Anforderungen an ein Testsystem 
und der daraus folgenden Architektur desselben. Unter einem Testsystem wird 
ein System verstanden, das zur Validierung und Verifikation des mit „Controller“ 
bezeichneten Objektes dient.

2.1.1 Entwicklung von Controllerfunktionalität und deren Validie-
rung
Abb. 2-1 zeigt den Controller, wie er im System Fahrzeug eingebettet ist und mit 
diesem wechselwirkt. Hinzu kommen im Gesamtmodell die Wechselwirkungen 
des Fahrzeugs (Vehicle) mit dem Fahrer (Driver) und diejenigen von Fahrer und 
Fahrzeug mit der Umwelt (Environment).

Der mit „Controller“ bezeichnete Block in der regelungstechnischen Darstellung 
in Abb. 2-1 beinhaltet im allgemeinen die Steueralgorithmen, die Überwa-
chungs- und Diagnosefunktionen. Er kann zudem Schnittstellen zur Außenwelt 
haben, die nicht mit den übrigen Komponenten in Wechselwirkung stehen, z.B. 
Diagnose und Mess- und Verstellschnittstellen.

Abb. 2-1 Fahrer, Fahrzeug und Umgebung (DVE)

Eine wichtige Voraussetzung für den Test von Controllerfunktionalität ist die 
Simulation von Fahrer, Fahrzeug und Umgebung (Driver, Vehicle, Environment, 
kurz: DVE). Zudem müssen Werkzeuge vorhanden sein, die systematische und 
automatisierte Tests ermöglichen.

Weiterhin muss berücksichtigt werden, dass beim Controller (im Weiteren all-
gemeiner „Unit under Test“ (UuT) genannt) während seiner Entwicklung eine 
zunehmende Zahl von „Schnittstellen“ bedient werden muss und Teile der DVE-
Simulation durch reale Komponenten (Aktoren, Sensoren) ersetzt werden.

Besteht die UuT anfangs nur aus Steuerungsalgorithmen, kommen mit der Zeit 
weitere Schnittstellen hinzu:

• Überwachung und Diagnose

• Verstellen

   Fahrzeug

Um-
gebung

Sollwert-
geber

Fahrer

Controller Aktuator Regel-
strecke Sensor
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Die UuT ist im Laufe ihrer Fortentwicklung insbesondere bezüglich seiner Kom-
plexität grossen Änderungen unterworfen. Es beginnt beim Modell einer Teil-
funktionalität und reicht (über das physikalische Steuergerät) zu einem 
kompletten Steuergeräteverbund.

Die Evolution der UuT im Entwicklungsprozess
Abb. 2-2 zeigt die Komplexitätsstufen, die die UuT bei ihrer Entwicklung durch-
läuft.

Abb. 2-2 Die Evolution der UuT im Entwicklungsprozess

• Softwarekomponente und -teilsystem

In dieser Entwicklungsstufe besteht die UuT aus einem in Software 
geschriebenen Modell einer Controllerfunktionalität.

• Microcontroller und Steuergerät

Auf den nächsten beiden Stufen besteht die UuT aus einem Hardware-
controller oder einem kompletten Steuergerät. Hier ist die UuT entweder 
eine auf einem Zieltarget (Microcontroller) realisierte Software oder 
bereits ein physikalisch vorhandenes Steuergerät.

• Steuergeräteverbund eines Fahrzeugteilsystems oder des Gesamt-
fahrzeuges

Auf der obersten Stufe besteht die UuT aus Verbünden von Steuergerä-
ten, die Teilsysteme des Fahrzeuges oder das ganze Fahrzeug steuern.

Level
Fahrzeug

System von
Steuergeräte-
netzwerken

UuT:

Level
Vehicle Subsystem
(z.B. Triebstrang)

Level
Steuergerät

Level
Microcontroller

Level
Software

UuT:

UuT:

UuT:

UuT:

Steuergeräte-
netzwerk

Steuergerät

µC

Software-
Subsystem
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2.1.2 Die allgemeine Architektur eines Testsystems
Damit ergibt sich die in Abb. 2-3 gezeigte allgemeine Architektur eines Test-
systems für die Controllerentwicklung. 

Abb. 2-3 Allgemeine Architektur eines Validierungssystems

• Im Mittelpunkt steht das Experiment, das sich aus der UuT und der 
Simulation von Fahrer, Fahrzeug und Umgebung (DVE) zusammensetzt. 

• Dieses Experiment wird von der Experimentiersoftware verwaltet, 
gesteuert und mit einer Instrumentierung versehen.

• Üblicherweise ist diese Experimentiersoftware über ein 
Automatisierungswerkzeug ansprechbar, das komplexe 
automatisierte Tests und Testauswertung ermöglicht. 

• Zur Erstellung und Bearbeitung des DVE-Modells oder modellierter 
Controllerfunktionalität kommt ein Modellierwerkzeug zum Einsatz.

• Mess- und Kalibrierwerkzeuge ermöglichen den direkten Zugriff auf die 
UuT.

• Der Zugriff auf Diagnoseschnittstellen der UuT erfolgt mit einem 
Diagnosewerkzeug.

Diese Architektur stellt alle typischerweise erforderlichen Funktionalitäten 
eines Testsystems zur Verwaltung und Steuerung des Experiments, zur Anpas-
sung des Modells an die sich verändernden Entwicklungsstufen der UuT und 
für den Zugriff auf Schnittstellen der UuT zur Verfügung.

Measurement, Calibration
& Diagnostics Tool

DVE
simulated DVE

real

UuT

DVE Models

DVE
Modeling Tools

Test Design Tool

Automation Tool

Experiment Tool
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2.2 LABCAR-OPERATOR 
LABCAR-OPERATOR wurde anhand dieser oben beschriebenen grundlegenden 
Anforderungen an ein System zur Entwicklung und Validierung von 
Controllerfunktionalität entwickelt. 

Seine Hauptfunktionen sind:

• Integrationsplattform (LABCAR-IP) für Funktionsmodule der verschie-
densten Art:

– MATLAB/Simulink-Modelle
– ASCET - Module
– I/O-Hardwaremodule
– C-Code Module
– CAN-, LIN- und FlexRay-Module
– Netzwerk-Module
– FiL-Module
– Module für Open-Loop-Zugriff und Signalbehandlung

• ETAS Experiment Environment (ETAS EE) für Hardware-in-the-Loop-
Anwendungen mit

– umfangreichen Instrumentierungsmöglichkeiten
– Echtzeitsignalgenerator und Datenlogger
– Visualisierung des Datenflusses vom Steuergerät über I/O-Hardware, 

Sensor-/Aktuator-Konfiguration und Simulationsmodell
– Zusatzprodukte zum Zugriff auf das Steuergerät über Mess- und Ver-

stell- oder Diagnoseschnittstellen (INCA)
• Fernsteuerung von Tests mit LABCAR-AUTOMATION
LABCAR-OPERATOR V5.4.13 - Schnelleinstieg 12
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2.2.1 Die Komponenten von LABCAR-OPERATOR V5.4.13
Abb. 2-4 zeigt den Aufbau und die Bestandteile von LABCAR-OPERATOR 
V5.4.13.

Abb. 2-4 Architektur von LABCAR-OPERATOR V5.4.13 

Im Folgenden werden die in Abb. 2-4 gezeigten Add-Ons zu LABCAR-OPERA-
TOR V5.4.13 beschrieben. 
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ETAS LABCAR-OPERATOR – Eine Übersicht
2.2.1.1 LABCAR-MCA V5.4.13 (Modeling Connector for ASCET)
In LABCAR-OPERATOR V5.4.13 können nun auch ASCET-Projekte als Module 
integriert werden, die zuvor aus ASCET (V6.0.1) für das Target „RTPC“ expor-
tiert wurden. Nach der Codegenerierung in LABCAR-IP stehen Ihnen dann die 
Messgrößen und Parameter in der Experimentierumgebung ETAS EE zur Verfü-
gung.

2.2.1.2 LABCAR-MCS V5.4.13 (Modeling Connector for Simulink)
Mit dem Modeling Connector for Simulink können Simulink-Modelle direkt - mit 
nur minimalsten Erweiterungen am Modell - eingesetzt werden. Die Verwaltung 
eines Projektes findet vollständig in LABCAR-OPERATOR statt. Hier werden alle 
Projektinformationen und -konfigurationen erstellt und gespeichert. 

Das Simulink-Modell kann sowohl für Model-in-the-Loop- als auch für 
Hardware-in-the-Loop-Experimente verwendet werden. Für beide Anwen-
dungsfälle wird das Modell mit sogenannten LABCAR Inports und LABCAR 
Outports versehen, über die Modellsignale untereinander als auch inbesondere 
Modell- und Hardwaresignale verbunden werden können. 

Für HiL-Anwendungen steht dafür der Connection Manager zur Verfügung. 
Hier werden dem Anwender sowohl alle Ein- und Ausgänge des Simulink-
Modells (sofern sie mit LABCAR Inports und Outports versehen worden sind) 
als auch die Signale der konfigurierten Hardware sichtbar gemacht. Die Verbin-
dungen zwischen Modell und Hardware werden hier erstellt und bearbeitet.

Diese Konfiguration wird im Projektzusammenhang von LABCAR-OPERATOR 
gespeichert - das Simulink-Modell bleibt von der jeweiligen Hardwarekonfigura-
tion unberührt. Damit können Verbindungen zur Hardware beliebig geändert 
werden, ohne dass der Modell-Code erneut generiert werden muss. Lediglich 
der Code für die geänderte Hardware oder für die geänderten Verbindungen im 
Connection Manager müssen neu erstellt werden.

Zudem steht dem Anwender eine Default-OS-Konfiguration zur Verfügung - 
Änderungen an OS-Konfigurationen wird eine Aufgabe nur für Experten, die im 
OS Configurator durchgeführt wird.

2.2.1.3 LABCAR-RTC V5.4.13 (Real-Time Execution Connector)
Die Installation von LABCAR-RTC V5.4.13 ist notwendig, wenn Sie LABCAR-
OPERATOR V5.4.13 zusammen mit Hardwarekomponenten in Echtzeitexperi-
menten einsetzen wollen. 

Der Real-Time Execution Connector dient der Integration und Parametrisierung 
von Hardwarekomponenten, die in HiL-Tests eingesetzt werden. Zudem kann 
im Online-Modus der Signalfluss durch die Hardwarekanäle visualisiert werden 
und Hardwareeinstellungen angepasst werden. Die gespeicherten Hardwarein-
formationen werden in der LABCAR-OPERATOR-Umgebung angezeigt.

2.2.1.4 LABCAR-CCI V5.4.13 (Calibration Connector for INCA)
LABCAR-CCI V5.4.13 gibt dem Anwender die Möglichkeit, das LABCAR-Experi-
ment mit einem INCA-Projekt zu verbinden, um im Experiment auf INCA-Daten 
zugreifen zu können - INCA-Labels des Experiments stehen zur Visualisierung 
in LABCAR-OPERATOR V5.4.13 zur Verfügung.
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ETAS LABCAR-OPERATOR – Eine Übersicht
Zusammen mit den ETAS Mess- und Verstellwerkzeugen ist damit ein direkter 
Steuergerätezugriff möglich - zudem stehen Schnittstellen zur Fernsteuerung 
von INCA über LABCAR-OPERATOR V5.4.13 zur Verfügung.

2.2.1.5 LABCAR-NIC V5.4.13 (Network Integration CAN)
Mit LABCAR-NIC V5.4.13 haben Sie die Möglichkeit, einen simulierten CAN-
Restbus zu konfigurieren und im Experiment mit diesem CAN-Botschaften aus-
zutauschen.

2.2.1.6 LABCAR-NIL V5.4.13 (Network Integration LIN)
Mit LABCAR-NIL V5.4.13 haben Sie die Möglichkeit, einen simulierten LIN-Rest-
bus zu konfigurieren und im Experiment mit diesem LIN-Botschaften auszutau-
schen.

2.2.1.7 LABCAR-NIF V5.4.13 (Network Integration FlexRay)
LABCAR-NIF V5.4.13 erlaubt Ihnen, zuvor mittels EB tresos Busmirror extra-
hierte Daten in Ihr LABCAR-OPERATOR-Projekt zu integrieren, um mit den Sig-
nalen des FlexRay-Moduls zu arbeiten.

2.2.1.8 LABCAR-LCE V5.4.13 (LABCAR Integration ETK)
LABCAR-LCE V5.4.13 ermöglicht die Erstellung und Integration von FiL-Modu-
len. Bei einem FiL-System werden einige (oder alle) elektrischen Verbindungen 
umgangen und auf den Speicher des Steuergerätes direkt zugegriffen – dazu 
muss das Steuergerät mit einem ETK ausgerüstet sein.

2.2.1.9 LABCAR-LCX V5.4.13 (LABCAR Integration XCP)
LABCAR-LCX V5.4.13 ermöglicht die Erstellung und Integration von FiL-Modu-
len zum direkten Steuergerätezugriff via XETK oder XCP on CAN.

2.2.2 LABCAR-IP
Die Integrationsplattform von LABCAR-OPERATOR V5.4.13 dient hauptsäch-
lich

• zum Import von Modulen unterschiedlicher Funktionalität in ein Projekt

• zur Konfiguration des I/O-Hardware-Moduls

• zur Verbindung zwischen diesen Modulen und

• zur Erzeugung von Code für das Simulationstarget „RTPC“

Darüber hinaus werden hier

• die OS-Einstellungen für die Echtzeitsimulation vorgenommen

und
• Signal Generator Sets für die Stimulation von Eingängen in Open-Loop-

Experimenten erstellt

INFO
Eine INCA-Lizenz ist im Produktumfang nicht enthalten.
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2.2.2.1 Die Bedienoberfläche
Die Bedienoberfläche von LABCAR-IP besteht aus den folgenden Objekten:

• Project Explorer, der alle Bestandteile des LABCAR-OPERATOR-Projek-
tes enthält

• Hauptarbeitsbereich, der (über verschiedenene Register) die wichtigen 
Bestandteile von LABCAR-IP zugänglich macht:

– Projektinformation
–  Connection Manager zur Verbindung von Signalen und zum Einfü-

gung von Module zur Signalkonvertierung
– CAN Editor zur Konfiguration der Restbus-Simulation (nur wenn LAB-

CAR-NIC V5.4.13 installiert ist und das CAN-Modul geöffnet wurde) 
– LIN Editor zur Konfiguration der Restbus-Simulation (nur wenn LAB-

CAR-NIL V5.4.13 installiert ist und das LIN-Modul geöffnet wurde)
– FlexRay Editor zur Konfiguration der Restbus-Simulation (nur wenn 

LABCAR-NIF V5.4.13 installiert ist und das FlexRay-Modul geöffnet 
wurde)

– OS Settings zur Konfiguration des Betriebssystems
– FiL Wizard zur Konfiguration von Fil-Modulen

• Fenster „Messages“ mit Informationen, Fehlermeldungen etc. zu Aktio-
nen und zur angeschlossenen Hardware

2.2.2.2 Module
Ein Modul besteht aus:

• Signaleingängen

• Signalausgängen
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• Funktionalität (in Form von Code)

• Messgrößen

• Parameter

• Prozesse, deren Ausführung in der Taskverwaltung des Echtzeit-
experimentes geplant wird

Folgende Arten von Modulen sind in LABCAR-OPERATOR V5.4.13 verwendbar:

• ASCET-Modelle 

ASCET-Modelle können mit LABCAR-MCA V5.4.13 eingebunden werden.
• Simulink-Modelle 

Simulink-Modelle können mit LABCAR-MCS V5.4.13 eingebunden wer-
den.

• C-Code-Module 

Auch beliebiger benutzerspezifischer C-Code kann als Modul eingebun-
den werden.

• CAN-Module 

Module für die Restbus-Simulation können mit LABCAR-NIC V5.4.13 
(Network Integration CAN) erstellt und bearbeitet werden.

• LIN-Module 

Module für die Restbus-Simulation können mit LABCAR-NIL V5.4.13 
(Network Integration LIN) erstellt und bearbeitet werden.

• Netzwerk-Module 

Das Netzwerk-Modul stellt Konfigurationen unter Verwendung von ver-
schiedenen Netzwerktypen für die Restbus-Simulation zur Verfügung.

• FlexRay-Module 

Module für die Simulation eines FlexRay-Busses können mit LABCAR-
NIF V5.4.13 (Network Integration FlexRay) integriert werden.

• FiL-Module 

Module für den Steuergerätezugriff über ETK/XETK können mit LAB-
CAR-LCE V5.4.13 erstellt und integriert werden.

• Hardware-Modul

Das bekannte RTIO-Modul zur Konfiguration der I/O-Hardware, erstellt 
und editierbar mit LABCAR-RTC V5.4.13 (Real-Time Execution Connec-
tor).

• Module zur Signalkonvertierung

In LABCAR-OPERATOR V5.4.13 neu eingeführt, wird hiermit die Modellie-
rung von Sensoren/Aktoren im Open-Loop-Betrieb wesentlich verein-
facht.

2.2.3 ETAS Experiment Environment
ETAS Experiment Environment (ETAS EE) ist die Umgebung zur Konfiguration 
(Instrumentierung, Parametrierung etc.) und Ausführung von Experimenten.

Im Detail bietet die neue Experimentierumgebung folgende Möglichkeiten:

• Übersichtlicher Zugriff auf alle Parameter und Messgrößen durch 
Vereinigung von „Element List“ und „Signal Center“ im Fenster 
„Workspace Elements.
LABCAR-OPERATOR V5.4.13 - Schnelleinstieg 17
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• Erstellen von Instrumentierungen zur Darstellung von Messgrößen und 
zur Änderung von Parametern des laufenden Experiments

• Signalkonvertierung und Sensor/Aktormodellierung

• Verfolgung („Tracing“) von Signalpfaden

• Datenaufzeichnung mit dem Datalogger

• Stimulierung von Eingängen mit dem Signal Generator

2.2.3.1 Das Fenster „Workspace Elements“
In LABCAR-OPERATOR V5.4.13 sind die Element List und das Signal Center in 
einer einzigen Ansicht zusammengefügt, der Ansicht „Workspace Elements“.

Abb. 2-5 Ausschnitt aus der Ansicht „Workspace Elements“

Hier hat der Anwender Zugriff auf 

• Messgrößen

• Parameter

• Eingänge
LABCAR-OPERATOR V5.4.13 - Schnelleinstieg 18
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• Ausgänge

und 
• Hardwarepins

des aktiven Experiments. 

In dieser Ansicht können Sie auf einfache Art und Weise Signale, Parameter und 
Messgrößen und die Hierarchien der Module durchsuchen. Dabei hilft Ihnen 
auch die Filterfunktion und die Suchfunktion des Fensters „Workspace Ele-
ments“.

2.2.3.2 Instrumentierung
Die Palette der Instrumente für die Darstellung von Messgrößen und Eingabe 
von Parametern wurde erheblich erweitert – desweiteren wurde ein neues 
Echtzeitoszilloskop entwickelt.

2.2.3.3 Open-Loop-Betrieb und Signalbearbeitung
Die konsequente Vereinheitlichung der Bestandteile des HiL-Experimentes in 
Form von Modulen ermöglicht einen systematischen Eingriff in den Signalver-
lauf.

Generische Aktor/Sensor-Module (basierend auf C-Code-Modulen) können an 
jeder Stelle im Signalverlauf eingesetzt werden. Jeder Eingang kann dazu ver-
wendet werden, die Signalkette aufzubrechen und den Eingang mit konstanten 
Werten oder Werten aus dem Signalgenerator zu stimulieren. 

In ETAS EE gibt es zur Verwaltung, Verfolgung und Bearbeitung von Signalen 
das Instrument „Signal List“. 

Nach dem Hinzufügen eines Signals zur Signal List können hier folgende Aktio-
nen durchgeführt werden:

• Verfolgen des Signalverlaufs

• Festlegung des Modus: Model, konstanter Wert oder Anschluss eines 
Signalgenerators für den Open-Loop-Betrieb.

2.2.4 Migration von älteren Projekten (ab V3.2.x)
Die Migration von Projekten, die mit LABCAR-OPERATOR V3.2.x und höher 
erstellt wurden, wurde bis LABCAR-OPERATOR V5.1.2 automatisch durchge-
führt, ab Version V5.2.x ist dies nicht mehr möglich. 

INFO
Wenn Sie ein solches Projekt mit LABCAR-OPERATOR V5.4.13 öffnen wollen,
muss dieses zuvor mit der Version V5.1.x geöffnet, migriert und wieder
gespeichert werden.
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Wenn das alte Projekt in LABCAR-IP geöffnet wird, wird der „Migration Wizard“ 
gestartet, der alle notwendigen Schritte durchführt.

Das erfolgreich migrierte Projekt wird dann im zuvor gewählten Verzeichnis 
unter dem gewählten Namen abgelegt.

Einschränkungen
Die automatisierte Migration von Projekten funktioniert nicht, wenn

• das Projekt (LABCAR-OPERATOR V3.2.x) ein LABCAR-DEVELOPER-Pro-
jekt enthält 

• bei Projekten mit Simulationstarget ES1130

Derartige Projekt müssen in LABCAR-OPERATOR V5.4.13 neu erstellt werden.
LABCAR-OPERATOR V5.4.13 - Schnelleinstieg 20
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3 Installation
Dieses Kapitel enthält Informationen über Lieferumfang, Hard- und Software-
voraussetzungen für die Installation und die Vorbereitung der Installation. 

3.1 Vorbereitung
Überprüfen Sie den Lieferumfang auf Vollständigkeit und Ihren Rechner auf 
Übereinstimmung mit den Systemvoraussetzungen. Je nach verwendetem 
Betriebssystem und Netzwerkanbindung müssen Sie sicherstellen, dass Sie 
die erforderlichen Benutzerrechte haben.

3.1.1 Lieferumfang
Zum Lieferumfang von LABCAR-OPERATOR V5.4.13 gehören:

• LABCAR-OPERATOR V5.4.13 DVD-ROM

– LABCAR-OPERATOR V5.4.13 Programmdateien
– Das aktuelle Hardware Service Pack (HSP)
– LABCAR-OPERATOR V5.4.13 Handbücher im PDF-Format
– Handbücher zur aktuellen LABCAR-Hardware im PDF-Format
– What’s New, Release Notes und weitere aktuelle Dokumentation

• Das Handbuch „LABCAR-OPERATOR V5.4.13 - Schnelleinstieg“

• Ein Dokument („License Entitlement“), das beschreibt, wie Sie die Lizen-
zen für die erworbenen Softwarekomponenten erhalten.

3.1.2 Systemvoraussetzungen
Folgende Systemvoraussetzungen sind für den Betrieb von LABCAR-OPERA-
TOR V5.4.13 erforderlich:

• Hardware:

– Prozessor Intel Pentium Dual-Core 2 GHz oder besser
– Hauptspeicher min. 4 GB; 8 GB empfohlen 
– Festplatte mit mindestens 20 GBSpeicherplatz (davon min 5 GB frei) 
– DVD-ROM-Laufwerk (für die Installation)
– Grafikkarte kompatibel mit DirectX 9 oder höher - Auflösung 

1280x1024, 16-Bit Farbe oder besser
– Ethernetkarte (10/100BaseT)

• Betriebssysteme:

– Windows 7 SP1 (32-Bit oder 64-Bit)
– Windows 8.1 (64-Bit)

INFO
Artefakte der LABCAR Software-Projekte beinhalten personenbezogene
Daten (z.B. Nutzernamen des Erstellers oder Nutzers). Ein Beispiel sind Log-
Dateien, die während der Laufzeit erstellt werden. Der Nutzer der Software ist
für die Einhaltung (lokaler) Gesetze und Regularien – wie etwa Löschung
personenbezogener Daten – verantwortlich.
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– Windows 10
Unterstützt werden folgende Sprachversionen der o.g. Betriebssysteme
– Englisch
– Deutsch
– Französisch
– Japanisch
– Koreanisch

3.1.3 Weitere Softwarevoraussetzungen
Die aktuelle Liste der für den Betrieb von LABCAR-OPERATOR V5.4.13 erforder-
lichen Softwareversionen finden Sie im Menü ? → Help im Dokument „LABCAR-
OPERATOR 5.x.y - Software Compatibility List“.

3.1.4 Benutzerrechte
Beachten Sie bitte folgende Hinweise bezüglich der Benutzerrechte bei Installa-
tion und Betrieb von LABCAR-OPERATOR.

3.1.4.1 Notwendige Benutzerrechte bei der Installation
• Um LABCAR-OPERATOR-Produkte auf dem PC zu installieren, benötigen 

Sie die Benutzerrechte eines Administrators. Wenden Sie sich gegebe-
nenfalls an Ihren Systemadministrator.

• Auf dem PC muss ein Verzeichnis für temporäre Dateien vorhanden sein 
(z.B. C:\TEMP), auf das alle Anwender Lese- und Schreibzugriff haben, 
die auf diesem PC mit LABCAR-OPERATOR arbeiten. 

3.1.4.2 Notwendige Benutzerrechte beim Betrieb
• Um mit den Produkten von LABCAR-OPERATOR zu arbeiten, muss jeder 

Anwender das Recht „Anheben der Zeitplanungspriorität“ vom Administ-
rator erhalten. Wenn Sie bereits INCA installiert haben, haben Sie dies bei 
der Installation (siehe Abbildung) möglicherweise bereits für einige 
Anwender durchgeführt.

• Alle LABCAR-OPERATOR-Anwender müssen auf den Registrierungs-
schlüssel 
„HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Cryptography\RNG“ 
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Schreibzugriff haben und darüber hinaus vollen Zugriff auf den Schlüs-
sel „HKEY_LOCAL_MACHINE\SOFTWARE\ETAS“ und die Schlüssel aller 
Unterverzeichnisse haben. 

• Alle Anwender von LABCAR-OPERATOR und der Standardbenutzer 
„Jeder” müssen volle Zugriffsrechte auf den Ordner \ETAS, dessen 
Unterverzeichnisse und auf die darin vorhandenen Dateien haben. Dies 
ist für die Codegenerierung mit dem GNU C-Compiler unbedingt erfor-
derlich.

3.1.5 Darstellung von HTML-basierten Inhalten 
Stellen Sie sicher, dass die Option „Ausführen aktiver Inhalte in Dateien auf dem 
lokalen Computer zulassen“ aktiviert ist. 

Sie finden diese Einstellungen in der Systemsteuerung unter „Internetoptionen“ 
im Register „Erweitert“.

3.2 Programminstallation
In diesem Abschnitt wird die Installation von LABCAR-OPERATOR V5.4.13 
beschrieben.

LABCAR-IP installieren
1. Legen Sie die Produkt-DVD in Ihr DVD-ROM-Laufwerk.

Der DVD-Browser wird gestartet.
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2. Wählen Sie 
Installation → Install LABCAR-OPERATOR.

Die Installation von HSP (Hardware Service Pack) können Sie 
später durchführen (siehe “HSP Update Tool” auf Seite 31).

Das Begrüßungsfenster wird geöffnet.

3. Klicken Sie Next und folgen Sie den Anweisungen des Installa-
tionsassistenten.

4. Zum Abschluss der Installation klicken Sie Finish.
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3.2.1 Startmenü
Der Startmenüordner Alle Programme → ETAS → LABCAR-OPERATOR X.Y 
enthält nach erfolgreicher Installation folgende Einträge:

• LABCAR-IP 

Startet die Integrationsplattform
• LABCAR-OPERATOR Tools 

Öffnet das LABCAR-OPERATOR-Verzeichnis \LCO Tools, in dem die 
folgenden Tools gestartet werden können:
– LABCAR-OPERATOR Version Selector 

Damit kann zwischen den Versionen umgeschaltet werden (siehe 
“LABCAR-OPERATOR-Version auswählen” auf Seite 26).

– MATLAB® Version Selector 
Hiermit kann die zu verwendende MATLAB-Version gewählt werden 
(siehe “MATLAB-Version auswählen” auf Seite 27).

– RT-Plugin Builder 
Startet eine Anwendung zur Erstellung von Realtime Plugins. 

• Manuals and Tutorials

Öffnet ein Datei-Explorerfenster für \ProgramData\ETAS\
ETASManuals\, das wiederum einen Link zu den Handbüchern von 
LABCAR-OPERATOR und LABCAR Hardware enthält.

Der Startmenüordner Alle Programme → ETAS → 
Experiment Environment X.Y enthält folgende Einträge:

• Experiment Environment VX.Y Tools 

Öffnet das Experiment Environment-Verzeichnis \EE Tools, in dem die 
folgenden Tools gestartet werden können:
– Associate to INCA 

Öffnet ein Dialogfenster, das ETAS EE mit einer bestimmten INCA-
Version verknüpft (siehe “INCA-Version auswählen” auf Seite 27).

– Associate to RTA Trace
Öffnet ein Dialogfenster, das ETAS EE mit einer bestimmten Version 
von RTA Trace-Version verknüpft.

• Experiment Environment VX.Y 

Startet die Experimentierumgebung ETAS EE
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• Manuals and Tutorials

Öffnet ein Datei-Explorerfenster für \ProgramData\ETAS\
ETASManuals\, das wiederum einen Link zur Online-Hilfe von ETAS EE 
enthält.

• TargetServernn Tools

Öffnet das Verzeichnis \ETAS\TargetServernn\Tools, in dem die 
folgenden Tools gestartet werden können:
– Search for connected hardware 

Der Target-Server wird gestartet und ein Suchvorgang nach ange-
schlossener Hardware durchgeführt.

– ETAS Network settings 
Startet des ETAS Network Manager zur Konfiguration Ihrer Netzwerk-
karte(n) für die ETAS Hardware und andere Netzwerke (siehe “ETAS 
Network Manager” auf Seite 68).

3.2.2 Programmversionen auswählen
Zum Abschluss der Installation sollten Sie noch für die im Umfeld von LABCAR-
OPERATOR eingesetzte Software festlegen, welche Versionen verwendet wer-
den sollen. Diese betrifft zum Einen die Version von LABCAR-OPERATOR selbst 
sowie die Version von Matlab/Simulink und INCA.

Für die aktuelle Liste der erforderlichen Softwareversionen lesen Sie das Kapi-
tel “Weitere Softwarevoraussetzungen” auf Seite 22.

LABCAR-OPERATOR-Version auswählen
Falls Sie mehrere Versionen von LABCAR-OPERATOR installiert haben, können 
Sie die zu verwendende Version festlegen. Gehen Sie dazu wie folgt vor:

1. Falls LABCAR-IP geöffnet ist, schließen Sie das Programm.

2. Wählen Sie im Start-Menü Alle Programme → ETAS → 
LABCAR-OPERATOR X.Y → 
LABCAR-OPERATOR VX.Y Tools → 
LABCAR-OPERATOR Version Selector.

Der LABCAR-OPERATOR Version Selector wird geöffnet.
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3. Wählen Sie die zukünftig zu verwendende Version und klicken 
Sie Switch.

Wenn der Wechsel erfolreich durchgeführt wurde, erhalten Sie 
folgende Bestätigung.

MATLAB-Version auswählen
Falls Sie mehrere Versionen von Matlab/Simulink installiert haben, können Sie 
die (bei der Integration von Simulink-Modellen) zu verwendende Version festle-
gen. Gehen Sie dazu wie folgt vor:

1. Wählen Sie im Start-Menü Alle Programme → ETAS → 
LABCAR-OPERATOR X.Y → 
LABCAR-OPERATOR VX.Y Tools → 
Matlab Version Selector.

Das Fenster „Select Matlab Version“ wird geöffnet.

2. Wählen Sie die zu verwendende Version aus der Liste „Installed 
Matlab Versions“.

3. Um die von LABCAR-OPERATOR V5.4.13 unterstützten Versio-
nen anzuzeigen, klicken Sie Supported Matlab Versions.

4. Um die Auswahl zu speichern, klicken Sie Select.

Die erfolgreiche Auswahl wird bestätigt.

5. Klicken Sie OK, um den Matlab Version Selector zu verlassen.

INCA-Version auswählen
Falls Sie mehrere Versionen von INCA installiert haben, können Sie die (beim 
Zugriff auf INCA-Experimente mit LABCAR-CCI V5.4.13) zu verwendende Ver-
sion festlegen. Diese Auswahl wird schon bei der Installation der 
Experimentierumgebung (ETAS EE) durchgeführt, kann aber jederzeit geändert 
werden. Gehen Sie dazu wie folgt vor:

INFO
Verwenden Sie immer den LABCAR Version Selector der aktuellen Version
von LABCAR-OPERATOR – ansonsten können doppelte Registry-Einträge zu
Problemen führen.
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1. Wählen Sie im Start-Menü Alle Programme → ETAS → 
Experiment Environment X.Y → 
Experiment Environment VX.Y Tools → 
Associate to INCA.

Das Fenster „Associate to INCA“ wird geöffnet.

2. Wählen Sie die zu verwendende Version aus der Liste .

3. Um die Auswahl zu speichern, klicken Sie Associate.

Die Installation des ETAS Target Servers wird gestartet.

4. Folgen Sie den Anweisungen des Installationsassistenten.

5. Geben Sie gegebenenfalls weitere Anwender an, die das Recht 
zum Anheben der Zeitplanungspriorität haben sollen.

Nähere Informationen hierzu siehe “Notwendige Benutzer-
rechte beim Betrieb” auf Seite 22.

6. Klicken Sie Next.

> Die Installation des Target Servers wird durchgeführt.

3.3 Lizenzierung
Um mit einem ETAS-Softwareprodukt arbeiten zu können, benötigen Sie eine 
Lizenz. Im Folgenden finden Sie einige grundlegenden Informationen zu die-
sem Thema. Details zum Umfang der Lizenzen und anderen rechtlichen Aspek-
ten finden Sie in den allgemeinen Geschäftsbedingungen (AGB).
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3.3.1 LABCAR-Lizenzmodelle
Für die Lizenzierung Ihrer LABCAR-Software sind zwei verschiedene Lizenz-
modelle vorgesehen.

3.3.1.1 Rechnerbezogene Lizenz („Machine Named“, lokal)
• Eine Lizenz dieses Typs wird vom Anwender selbst verwaltet.

• Da Sie an den jeweiligen PC (besser: an die MAC-Adresse des Ethernet-
Adapters) gebunden ist, gilt sie überall, wo der PC eingesetzt wird.

• Beim Wechsel des PCs benötigen Sie eine neue Lizenz

3.3.1.2 Mehrfachnutzer-Lizenz („Concurrent“ oder „Floating“, Server-
basiert)
Für diesen Typ gilt weitgehend dasselbe wie für die nutzerbezogene Lizenz. Der 
Unterschied besteht darin, dass sich hierbei mehrere Nutzer (unabhängig vom 
Benutzernamen) eine begrenzte Anzahl von Lizenzen teilen.

3.3.2 Wie erhalte ich eine Lizenz?
Wenn Ihre Firma einen Tool-Koordinator und eine Server-basierte Lizenzverwal-
tung für ETAS-Software besitzt, so wenden Sie sich an diese Person. Im ande-
ren Fall (rechnerbezogene Lizenz) erhalten Sie Ihre Lizenz über das ETAS-
Lizenzportal (die URL finden Sie in Ihrem Entitlement Certificate). 

Auf der Startseite gibt es drei Arten, sich einzuloggen:

• Activation ID 

Nach dem Einloggen ist eine bestimmte Activation1 sichtbar und kann 
verwaltet werden – die Activation ID finden Sie im Entitlement Certifi-
cate.

• Entitlement ID 

Hier sind alle Activations des Entitlements2 sichtbar und können verwal-
tet werden (z.B. für ein Unternehmen mit nur einem Entitlement).

• E-mail and Password 

Alle Activations der Entitlements, die dem Nutzerkonto zugeordnet wur-
den, sind sichtbar und können verwaltet werden (z.B. für einen Tool-
Koordinator mit Verantwortung für mehrere Entitlements)

Für Hilfe im Portal klicken Sie den Link Hilfe.

3.3.2.1 Welche Informationen werden benötigt?
Um Lizenzen zu aktivieren, müssen Informationen zu den Hosts eingegeben 
werden:

1. Die Activations beziehen sich auf ein bestimmtes Produkt, seine Lizenz-
bedingungen, die verfügbare Anzahl an Lizenzen und weitere Details, die für die 
Erzeugung einer Lizenz erforderlich sind. Activations sind durch Activation IDs 
eindeutig identifiziert. 

2. Ein Entitlement zeigt an, welche Berechtigungen Sie als Nutzer haben; es steht 
für das Recht, eine oder mehr Lizenzen für ein Produkt zu erhalten. Es ist eine Art 
Konto von Nutzungsrechten für Software, aus dem Sie sich bei Bedarf Lizenzen 
entnehmen können. 
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• Rechnerbezogene Lizenz

Hier wird die MAC Adresse des Ethernet-Adapters benötigt, an den die 
Lizenz gebunden sein soll.

• Concurrent (Floating) Lizenz.

Hier wird die MAC-Adresse oder Host-ID für einen Server Host oder eine 
Server Triade benötigt.

3.3.2.2 Lizenzdatei
Ergebnis Ihrer Aktivtäten ist die Bereitstellung einer Datei <name>.lic, mit der 
Sie im ETAS-Lizenz-Manager Ihre jeweilige Software lizenzieren können.

Lizenzstatus einsehen
1. Wählen Sie im Windows Start Menü in der App-Liste E → 

ETAS → ETAS License Manager.

Der ETAS-Lizenz-Manager wird geöffnet.

Der ETAS-Lizenz-Manager enthält einen Eintrag für jedes ins-
tallierte Produkt. Das Symbol vor einem Eintrag und die Spalte 
„Status“ zeigen an, ob schon eine gültige Lizenz vorliegt oder 
nicht.

- Weitere Informationen zur Verwaltung von Lizenzen finden Sie 
in der Online-Hilfe (<F1>).

INFO
Wenn sich o.g. Daten ändern (z.B. durch Hardwareänderungen oder Benut-
zerwechsel), muss für die Lizenz ein sog. „Rehost“ durchgeführt werden. Das
Verfahren wird in der Hilfedatei im Portal beschrieben.
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3.4 HSP Update Tool 
Zur Aktualisierung Ihrer Hardware wird das HSP Update Tool mitgeliefert, mit 
dem Sie (mit dem aktuellen Hardware Service Pack von Ihrer Produkt-DVD) Ihre 
Hardware auf den neuesten Firmwarestand aktualisieren können.

Installation
1. Legen Sie die Produkt-DVD in Ihr DVD-ROM-Laufwerk.

Der DVD-Browser wird gestartet.

2. Wählen Sie Installation → Install HSP <Versionsnummer>.

3. Klicken Sie Next.

Die Installation wird gestartet. 

4. Folgen Sie den Anweisungen in den Dialogfenstern.

5. Zum Abschluss der Installation klicken Sie Fertigstellen.
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Firmware-Update durchführen
1. Starten Sie das HSP Update Tool in LABCAR-IP über Tools → 

HSP Update Tool.

Das HSP Update Tool wird gestartet.

2. Wählen Sie Hilfe → Kurzanleitung.

Ein Hilfe-Fenster mit Anweisungen zur Durchführung des 
Updates wird geöffnet.

3. Führen Sie das Firmware-Update wie beschrieben durch.

3.5 Die Netzwerkverbindung zum Real-Time PC
Die Verbindung zwischen Ihrem Bedien-PC und dem Target „RTPC“ erfolgt zwi-
schen einer zweiten Ethernetkarte im Bedien-PC und dem Anschluss „ETH0“ 
Ihres Real-Time PCs. Anschließend konfigurieren Sie die Karte in Ihrem Bedien-
PC mit der festen Netzwerkadresse 192.168.40.240 (Subnetzmaske: 
255.255.255.0)

Weitere Informationen finden Sie im „ETAS RTPC V6.5.2 - Benutzerhandbuch“ 
und im Kapitel “ETAS Network Manager” auf Seite 68.
LABCAR-OPERATOR V5.4.13 - Schnelleinstieg 32



ETAS Tutorial
4 Tutorial
In diesem Kapitel wird anhand eines einfachen Beispiels beschrieben, wie Sie 
ein LABCAR-OPERATOR Projekt erstellen und mit diesem arbeiten.

Dieses Tutorial ist wie folgt aufgebaut:

• “Das Modell „IdleController“” auf Seite 33

In diesem Abschnitt finden Sie eine kurze Beschreibung des für dieses 
Projekt verwendeten Simulink-Modells „IdleController.mdl“.

• “Erstellen des LABCAR-OPERATOR-Projekts” auf Seite 35

In diesem Abschnitt werden die grundlegenden Schritte bei der 
Projekterstellung mit LABCAR-MCS V5.4.13 (Modeling Connector for 
Simulink) beschrieben.

• “Messwerte anzeigen und Parameter verstellen” auf Seite 40

In dieser Lektion erstellen Sie ein Anzeigeelement für die Motordrehzahl 
und einen Schalter, mit dem die Klimaanlage zu- und abgeschaltet wer-
den kann.

• “Hardware konfigurieren” auf Seite 48

Im Rahmen dieses Tutorials ist es nicht möglich, ein echtes HiL-Experi-
ment aufzubauen - dieser Abschnitt soll dazu dienen, den Umgang mit 
den Werkzeugen und Funktionen von LABCAR-MCS für diesen Einsatz-
bereich zu demonstrieren.

• “Inport hinzufügen” auf Seite 51

Bevor Sie die Hardware mit Modellsignalen verbinden können, müssen 
Sie die zu verwendenden Modellsignale in Simulink mit LABCAR Inports 
oder Outports versehen.

• “Signale im Connection Manager verbinden” auf Seite 54

Im Connection Manager wird schließlich das Signal des A/D-Wandlers 
(„0“ oder „1“) mit dem Modelleingang „AirConditionManual“ verbunden.

• “Konfiguration des Echtzeit-Betriebssystems” auf Seite 56

LABCAR-OPERATOR V5.4.13 legt für jedes neue Projekt eine Standard-
OS-Konfiguration an, in der alle benötigten Tasks vorhanden sind und 
alle Prozesse diesen zugewiesen sind.

• “Experiment ausführen” auf Seite 57

In diesem Abschnitt finden Sie eine Beschreibung der letzten Schritte, 
bevor Sie das Experiment durchführen.

• “Aufzeichnen mit dem Datalogger” auf Seite 62 

In diesem Abschnitt finden Sie eine Anleitung, wie Sie Signale mit dem 
Datalogger aufzeichnen.

4.1 Das Modell „IdleController“
In diesem Abschnitt finden Sie eine kurze Beschreibung des für dieses Projekt 
verwendeten Simulink-Modells „IdleController.mdl“.

Abb. 4-1 zeigt das verwendete Simulink-Modell, das aus einem einfachen 
Motormodell „Pedal2NEngine“ und dem eigentlichen Leerlauf-Controller „A_Id-
leController“ besteht. 
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Der Controller hat als Eingang die Gaspedalstellung vom Fahrer und die Motor-
drehzahl - im Leerlauf wird eine vorgegebene Drehzahl gehalten.

Abb. 4-1 Das Gesamtmodell „IdleController.mdl“

Im eigentlichen Motormodell (Abb. 4-2) wird aus der Gaspedalstellung („Acce-
lerator_Input“) das Drehmoment errechnet, aus dem wiederum die Motordreh-
zahl berechnet wird. Zudem ist es möglich, zusätzlich eine Klimaanlage 
zuzuschalten, die dann natürlich Drehmoment kostet und - insbesondere im 
Leerlauf - die Drehzahl erniedrigt. Bei dieser Drehzahlerniedrigung wird der 
Leerlauf-Controller aktiv, der an das Motormodell eine korrigierte Gaspedalstel-
lung liefert, um die Drehzahl wieder auf die geforderte Solldrehzahl zu regeln.

Geschaltet wird die Klimaanlage über den Wert von „AirConditionManual“ links 
oben in Abb. 4-2. In diesem Tutorial wird dieser Wert zuerst über ein Bedien-
fenster geändert und anschließend über eine A/D-Wandler-Hardware einge-
speist.

Abb. 4-2 Das Motormodell „Pedal2NEngine“
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4.2 Erstellen des LABCAR-OPERATOR-Projekts
In diesem Abschnitt werden die grundlegenden Schritte bei der 
Projekterstellung mit LABCAR-MCS V5.4.13 (Modeling Connector for Simulink) 
beschrieben.

LABCAR-OPERATOR starten
1. Wählen Sie Start → Alle Programme → ETAS → LABCAR-

OPERATOR X.Y → LABCAR-IP.

oder
1. Doppelklicken Sie das Programmsymbol auf dem Desktop.

LABCAR-OPERATOR wird gestartet und das Hauptfenster wird 
geöffnet.  

Eine ausführliche Beschreibung der Bedienoberfläche finden 
Sie im LABCAR-OPERATOR V5.4.13 - Benutzerhandbuch.
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Ein LABCAR-OPERATOR Projekt erstellen
1. Wählen Sie File → New Project. 

Der Project Wizard wird geöffnet.

2. Wählen Sie unter „Location“ ein Verzeichnis, in dem das neue 
Projekt angelegt werden soll.

3. Geben Sie unter „Project Name“ einen Projektnamen an.

4. Weisen Sie diesem Target unter „Target Name“ ggf. einen spe-
ziellen Namen zu.

5. Klicken Sie Finish.

> Das Projekt (ohne Module und Hardware) wird erstellt.

Simulink-Modell integrieren
1. Wählen Sie Project → Add Module.

oder
1. Klicken Sie das Symbol Add Module.

oder
1. Rechtsklicken Sie auf das Target „RTPC“ und wählen Sie im 

Kontextmenü Add Module.

Der Add Module Wizard wird geöffnet.
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2. Wählen Sie die Option „Add Simulink (TM) Module“.

3. Klicken Sie Next.

4. Wählen Sie „Use existing Simulink Model“.
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5. Klicken Sie Next.

6. Wählen Sie mit Browse das Simulink-Modell aus, das Sie ver-
wenden möchten.

Das Modell "IdleController.mdl" finden Sie im Verzeich-
nis 
<Laufwerk>:\Program Files\ETAS\
LABCAR-OPERATORX.Y\Manuals\
Tutorial. 

> Ist die Option „Copy Model Directory into Project“ gewählt, wird 
das Simulink-Modell und die dazu gehörenden Dateien in das 
Projektverzeichnis kopiert – ansonsten wird das angegebene 
Modell lediglich aus dem Projekt heraus referenziert.

> Mit Advanced Settings können Sie weitere Vorgaben bezüg-
lich externer Dateien und Verzeichnisse machen (siehe LAB-
CAR-OPERATOR V5.4.13 - Benutzerhandbuch) - für dieses 
Beispiel ist dies nicht notwendig.

7. Wählen Sie Finish.

> Das Projekt wird erstellt und die entsprechenden Verzeich-
nisse und Dateien auf Ihrer Festplatte angelegt.

> Im Project Explorer wird der Verzeichnisbaum des Projekts 
angelegt.
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Nach dem Anlegen des Projekts kann jetzt der Code erzeugt werden.

Code erzeugen
1. Wählen Sie Project → Build... 

oder
1. Klicken Sie das Symbol Build LABCAR Project.

2. Wählen Sie im folgenden Fenster die Module aus, für die Code 
erzeugt werden soll.

3. Klicken Sie Build.

> Die Codegenerierung für die gewählten Module wird durchge-
führt. 

> Eine erfolgreiche Codegenerierung wird anschließend im 
Register „Messages“ angezeigt.

Mit dem erfolgreich erzeugten Code können Sie jetzt in der Experimentier-
umgebung ETAS EE ein Experiment öffnen, konfigurieren und ausführen.

INFO
Stellen Sie sicher, dass ihr Experimentaltarget ordnungsgemäß angeschlos-
sen ist und betriebsbereit ist!

INFO
Nach der erstmaligen Codegenerierung wird ETAS EE automatisch gestartet
und ein Workspace für dieses Experiment erzeugt.
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Experiment in ETAS EE starten
1. Klicken Sie das Symbol Open Experiment Environment.

ETAS EE wird gestartet und das Experiment geöffnet.

Im Fenster „Workspace Elements“ sind alle Parameter, Messgrößen, Ein- und 
Ausgänge des Modells in der entsprechenden Hierarchie aufgeführt.

Im Hauptarbeitsbereich können Sie die Instrumentierung erstellen (in mehreren 
„Layern“), den Datalogger konfigurieren und bedienen (Register „Datalogger“) 
und Signalgeneratoren erstellen und bedienen (Register „Signal Generator“).

4.3 Messwerte anzeigen und Parameter verstellen
In dieser Lektion erstellen Sie ein Anzeigeelement für die Motordrehzahl und 
einen Schalter, mit dem die Klimaanlage zu- und abgeschaltet werden kann.

Ein Oszilloskop erstellen
1. Um ein Oszilloskop zur Anzeige der Motordrehzahl zu erstel-

len, klicken Sie in der Werkzeugleiste das Symbol Add Oscillo-
scope.

Ein Oszilloskopfenster wird geöffnet.

2. Suchen Sie im Fenster „Workspace Elements“ (unter 
„Search&Filter“) nach dem Ordner „TorqueToNEngine“.

3. Klicken Sie die Hierarchie auf, bis Sie das Label „TorqueToNEn-
gine\Out“ sehen.
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4. Wählen Sie „Out“ und ziehen Sie diese bei gedrückter linker 
Maustaste in das Oszilloskopfenster.

5. Lassen Sie die Maustaste über dem Oszilloskopfenster wieder 
los.

Das Fenster „Create Instruments“ wird geöffnet.

6. Wählen Sie „Acquisition“ als Task zur Erfassung der Mess-
größe. 
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7. Klicken Sie OK.

Die Messgröße wird zum Oszilloskop hinzugefügt

Der Name der darzustellenden Variablen wird in der Legende 
angezeigt.

Im Folgenden erstellen Sie einen Schalter, mit dem die Klimaanlage ein- und 
ausgeschaltet wird.

Einen Schalter für die Klimaanlage erstellen
1. Suchen Sie im Fenster „Workspace Elements“ den Parameter 

„Value“ im Ordner „AirConditionManual“.

Ein anderer Weg zur Erstellung eines Bedien- oder Anzeigeele-
ment ist der folgende:

2. Rechtsklicken Sie den Parameter „Value“.

INFO
Messgrößen werden immer im Raster der Task aufgezeichnet, der sie zuge-
ordnet sind - beträgt dieses Raster weniger als 5 ms, sind folgende Ein-
schränkungen zu beachten: 
1. In diesem Bereich kann eine lückenlose Aufzeichnung von Messwerten
nicht mehr gewährleistet werden. Zur lückenlosen Aufzeichnung der Messda-
ten verwenden Sie bitte den Datalogger. 
2. Die x-Werte (= Zeit) der dargestellten Messpunkte stimmen möglicher-
weise nicht mehr exakt mit diesem Raster überein - es kann zu minimalen
Zeitverzögerungen kommen.
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3. Wählen Sie Measure / Calibrate.

Das Fenster „Create Instruments“ wird geöffnet.

4. Unter „Instrument Type“ wählen Sie „On/Off“.

5. Unter „Group“ wählen Sie „<New Group>“.

6. Klicken Sie OK.

Das Bedienelement wird erstellt.

7. Wählen Sie den inneren Bereich des Bedienelements und 
gehen Sie in das Fenster „Properties“.
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8. Ersetzen Sie unter „Label Format“ die Zeichenkette „%Default“ 
durch „Air Condition“.

Der Schalter hat damit die entsprechende Beschriftung.

9. Fügen Sie ebenfalls den Parameter „Value“ zum Oszilloskop 
hinzu.
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Experiment zum Target herunterladen
1. Stellen Sie sicher, dass das bei der Projekterstellung angege-

bene Simulationstarget angeschlossen und eingeschaltet ist.

2. Wählen Sie Experiment → Download → LABCAR.

oder
- Klicken Sie den Pfeil neben dem Symbol Download und 

wählen Sie LABCAR.
Das Experiment wird zum Experimentaltarget heruntergela-
den.

> Ein erfolgreiches Herunterladen wird Ihnen im Log-Fenster 
angezeigt.
LABCAR-OPERATOR V5.4.13 - Schnelleinstieg 45



ETAS Tutorial
Experiment durchführen
1. Starten Sie die Simulation mit Experiment → Start 

Simulation → LABCAR

oder
1. Klicken Sie neben den Symbol Start Simulation den Pfeil und 

wählen Sie LABCAR

Die Messgröße wird im Oszilloskop angezeigt.

Nach einiger Zeit regelt sich die Leerlaufdrehzahl auf 750 U/
min ein.

2. Zur Darstellung der Drehzahl und des Parameters zum An- und 
Ausschalten der Klimaanlage in jeweils eigenen Koordinaten-
systemen rechtsklicken Sie in das Koordinatensystem und 
wählen Sie Single Axis per Channel.

3. Um für die jeweilige y-Achse den maximal notwendigen 
Bereich zur Darstellung auszunutzen, wählen Sie die jeweilige 
Achse.
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4. Rechtsklicken Sie und wählen Sie Zoom to Fit.

5. Verschieben Sie ggf. die y-Achsen mit der Maus.

6. Schalten Sie jetzt die Klimaanlage mit dem zuvor erstellten 
Schalter „Air Condition“ an.

Die Leerlaufdrehzahl bricht aufgrund des zusätzlichen 
Moments kurz ein und wird vom Leerlaufregler wieder ausge-
regelt.

7. Schalten Sie die Klimaanlage wieder aus.

Die vom Leerlaufregler korrigierte Pedalstellung führt zu einer 
kurzzeitigen Drehzahlerhöhung, die ebenfalls wieder ausgere-
gelt wird.

8. Halten Sie das Experiment durch Klicken des Symbols Stop 
Simulation an.

oder
- Wählen Sie Experiment → Stop Simulation → LABCAR
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- Beenden Sie das Experiment durch Klicken des Symbols 
Disconnect.

oder
- Wählen Sie Experiment → Disconnect →  LABCAR
- Wählen Sie File → Save Experiment.
- Wählen Sie File → Exit.

Wechseln Sie zur Konfiguration der Hardware wieder zurück zu LABCAR-IP.

4.4 Hardware konfigurieren
Im Rahmen dieses Tutorials ist es nicht möglich, ein echtes HiL-Experiment 
aufzubauen - dieser Abschnitt soll dazu dienen, den Umgang mit den Werkzeu-
gen und Funktionen von LABCAR-MCS für diesen Einsatzbereich zu demonst-
rieren.

Im Folgenden wird eine A/D-Wandler-Hardware eingesetzt (PB1651ADC1 A/D 
Module auf einem ES1651.1 Carrier Board) – damit kann ein Spannungssignal 
zwischen 0 und 10 V zum Ein- oder Ausschalten der Klimaanlage verwendet 
werden.

Eine Hardwarekonfiguration erstellen
1. Öffnen Sie LABCAR-IP.

2. Wählen Sie Project → RTIO Editor.

oder
- Klicken Sie das Symbol Edit Hardware Configuration.

oder
- Wählen Sie das Hardware-Module und wählen Sie Edit aus 

dem Kontextmenü.

Der RTIO-Editor wird geöffnet. Im Baum der HWC-Items befin-
det sich bereits das bei der Projekterstellung angegebene 
Simulationstarget (hier: RTPC).
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3. Wählen Sie das System „Domain“ unterhalb des Simulations-
targets „RTPC“.

4. Wählen Sie Edit → Add Item.

Das „Add Items“ Fenster wird geöffnet.

5. Wählen Sie das Item „ES1651-CB“.

6. Klicken Sie OK.

Das ES1651.1 Carrier Board wird zur Hardwarekonfiguration 
hinzugefügt.

7. Wählen Sie diesen neuen Eintrag in der Liste „Items“.

8. Wählen Sie erneut Edit → Add Item.
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9. Im „Add Items“ Fenster wählen Sie das Item „PB1651ADC1“.

10.Klicken Sie OK.

Das PB1651ADC1.1 Modul wird zur Hardwarekonfiguration 
hinzugefügt.

11.Wählen Sie die Registerkarte „Signals“.

12.Wählen Sie das Signal „AnaIn_0“.

13.Klicken Sie zweimal in die Zelle unter „Operating Mode“.

14.Wählen Sie „Comparator“ als Betriebsart.

15.Doppelklicken Sie die Zelle unter „Threshold [V]“.

16.Geben Sie den Wert „5.0“ ein.

Damit wurde der Kanal als Komparator definiert - bei Spannun-
gen < 5 V nimmt das Signal den Wert „0“ an, ansonsten den 
Wert „1“.

17.Klicken Sie Accept.

18.Wählen Sie File → Save.
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19.Schließen Sie LABCAR-RTC mit File → Exit.

4.5 Inport hinzufügen
Bevor Sie die Hardware mit Modellsignalen verbinden können, müssen Sie die 
zu verwendenden Modellsignale in Simulink mit LABCAR Inports oder Outports 
versehen.

Einen Inport hinzufügen
1. Wählen Sie im Project Explorer das Modell „IdleController“.

2. Im Kontextmenü wählen Sie Edit.

Das zum Projekt gehörende Modell wird in Simulink geöffnet.

3. Falls der Block „Pedal2NEngine“ noch nicht geöffnet worden 
ist, doppelklicken Sie diesen.

Der Parameter „AirConditionManual“ soll nun über eine A/D-Wandler-Hardware 
ins Modell eingespeist werden. Dazu muss für das entsprechende Signal ein 
LABCAR Inport (an Stelle der Konstanten) zum Modell hinzugefügt werden.

4. In Simulink wählen Sie View → Library Browser.

Der Simulink Library Browser wird geöffnet.
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5. Öffnen Sie die Library „LABCAR Port Blocks“.

6. Wählen Sie mit der Maus einen Input Port und ziehen Sie ihn 
ins Modell.

7. Löschen Sie den Block „AirConditionManual“.

8. Bennnen Sie den LABCAR Inport in „AirConditionManual“ um.
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9. Verbinden Sie den LABCAR Inport mit dem freien Eingang.

10.Speichern Sie die Änderungen mit File → Save.
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4.6 Signale im Connection Manager verbinden
Im Connection Manager wird schließlich das Signal des A/D-Wandlers („0“ oder 
„1“) mit dem Modelleingang „AirConditionManual“ verbunden.

Den Connection Manager öffnen
1. Wählen Sie das Register „Connection Manager“ im Hauptfens-

ter von LABCAR-OPERATOR V5.4.13.

Der Connection Manager wird angezeigt.

2. Klicken Sie Update Ports, um die Darstellung aller Hardware- 
und Modellanschlüsse zu aktualisieren.

Eine Verbindung zwischen Modell und Hardware erstellen
1. Wählen Sie mit der Maus den Hardwareausgang „AnaIn_0“) 

und den Modelleingang („AirConditionManual“).
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2. Klicken Sie das Symbol zum Verbinden der gewählten Signale.

oder
- Wählen Sie einen Ausgang mit der Maus und schieben Sie 

ihn auf den gewünschten Eingang.
Die Verbindung wird erstellt und im Feld „Existing Connections“ 
dargestellt (sofern nicht ein Filter aktiv ist, der die neu erstellte 
Verbindung ausblendet).

Um anzuzeigen, dass dieser Ausgang mit einem Eingang ver-
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bunden wurde, werden die beiden Anschlüsse jetzt mit blauer 
Schrift dargestellt.

3. Speichern Sie die Änderungen mit File → Save All.

4.7 Konfiguration des Echtzeit-Betriebssystems
LABCAR-OPERATOR V5.4.13 legt für jedes neue Projekt eine Standard-OS-Kon-
figuration an, in der alle benötigten Tasks vorhanden sind und alle Prozesse 
diesen zugewiesen sind. 

Um den OS Configurator kennenzulernen, öffnen Sie diesen wie im Folgenden 
beschrieben - eine detaillierte Beschreibung finden Sie im LABCAR-OPERATOR 
V5.4.13 - Benutzerhandbuch.

OS Configurator öffnen
1. Wählen Sie das Register „OS Configuration“ im Hauptfenster 

von LABCAR-IP.

Das Fenster „OS Configuration“ wird angezeigt.

2. Um sämtliche Informationen einsehen zu können, öffnen Sie 
alle Elemente der beiden Baumansichten und klicken Sie das 
Symbol mit dem blauen Pfeil.

3. Klicken Sie Update Processes.

Im Fenster „Processes“ (links) sind alle Hardware- und Modell-
prozesse aufgeführt, im Fenster „Tasks“ alle automatisch 
erstellten Task und die zugeordneten Prozesse.

Die automatische Zuordnung kann so übernommen werden.

4. Speichern Sie die Änderungen mit File → Save All.
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4.8 Experiment ausführen
In diesem Abschnitt finden Sie eine Beschreibung der letzten Schritte, bevor Sie 
das Experiment durchführen.

Im Einzelnen sind dies:

• “Code erzeugen” auf Seite 57

• “Einen neuen Layer für die Instrumentierung erstellen” auf Seite 58

• “Messgrößen in Oszilloskop darstellen” auf Seite 58

• “Signalkette öffnen” auf Seite 59

• “Spannungsquelle an ADC-Modul anschließen” auf Seite 61

• “Experiment starten” auf Seite 61

Code erzeugen
1. Stellen Sie sicher, dass das bei der Projekterstellung angege-

bene Simulationstarget angeschlossen und eingeschaltet ist.

2. Wählen Sie Project → Build.

3. Wählen Sie die zu erstellenden Module.

4. Klicken Sie Build.

Die Codegenerierung für das Modell, die Hardwarekonfigura-
tion und den Connection Manager wird gestartet und eine aus-
führbare Datei erzeugt.

5. Vergewissern Sie sich im Register „Messages“, dass der Build-
Prozess erfolgreich war.

Sollten Fehler auftreten, so wird ein separates Fenster mit aus-
führlichen Informationen geöffnet.
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6. Klicken Sie das Symbol Experiment Environment.

ETAS EE wird gestartet und das Experiment geöffnet.

Einen neuen Layer für die Instrumentierung erstellen
Im Register „Instrumentation“ befindet sich jetzt der zuvor erstellte Layer mit 
dem Oszilloskop und dem Schalter für die Klimaanlage. Dieser Schalter ist jetzt 
hervorgehoben, das andeutet, dass der zugewiesene Parameter nicht mehr 
existiert (weil er durch einen LABCAR Inport ersetzt wurde).

1. Klicken Sie auf den Namen des Layers und wählen Sie Rename 
Layer.

2. Weisen Sie ihm beispielsweise den Namen „Experiment wit-
hout hardware“ zu.

3. Klicken Sie in der Umgebung der Registerkarte und wählen Sie 
Create Layer.

4. Nennen Sie den neuen Layer beispielsweise „Experiment with 
hardware“.

Messgrößen in Oszilloskop darstellen
1. Um in dem neuen Layer ein Oszilloskop zur Anzeige der Motor-

drehzahl zu erstellen, klicken Sie in der Werkzeugleiste das 
Symbol Add Oscilloscope.

2. Fügen Sie die Messgröße für die Drehzahl „IdleController/
Pedal2NEngine/TorqueToNEngine/Out“ per Drag&Drop hinzu.
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3. Fügen Sie ebenfalls den neu hinzugekommenen Modellein-
gang „AirConditionManual“ hinzu.

4. Laden Sie das Experiment zum Simulationstarget herunter.

5. Starten Sie die Simulation.

Die Leerlaufdrehzahl erreicht ihren Normwert und der Wert von 
„AirConditionManual“ beträgt „0“, da am Hardwareingang keine 
Spannung anliegt und somit der D/A-Wandler auch kein 
Ausgangssignal liefert.

6. Halten Sie die Simulation wieder an.

7. Wählen Sie File → Save Experiment.

Bevor die I/O-Hardware eingesetzt wird, soll an dieser Stelle die Funktion des 
Instruments „Signal List“ demonstriert werden.

Signalkette öffnen
1. Wählen Sie in den Workspace Elements den vorhin erstellten 

Modelleingang „AirConditionManual“.

2. Rechtsklicken Sie und wählen Sie Signal → Trace.

Das Fenster „Select the Tracing Mode“ wird geöffnet.
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3. Wählen Sie „backward“ und „<New Group>“ und klicken Sie OK.

Ein neues Instrument vom Typ „Signal List“ wird geöffnet.

Sie sehen hier die zuvor im Connection Manager erstellte Ver-
bindung zwischen dem A/D-Wandler-Modul und dem Modell-
anschluss.

4. Wählen Sie den inneren Bereich der Signal List mit der Maus.

5. Ändern Sie im Fenster „Properties“ den Eintrag „Label Format“ 
von „%HIERARCHY0“ zu „%HIERARCHY2“.

Dadurch wird die volle Hierarchie der Signalnamen dargestellt:

6. Um diese Verbindung vorübergehend zu unterbrechen, wählen 
Sie aus der Liste in der Spalte „Mode“ den Eintrag „CONST“.

Damit liegt an diesem Eingang jetzt ein konstanter Wert an, der 
in der Spalte „Constant“ spezifiziert wird.

7. Starten Sie die Simulation.
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8. Ändern Sie den Wert in der Spalte „Constant“ auf 1 (danach 
<Return> drücken).

Wieder bricht die Leerlaufdrehzahl kurz ein und wird wieder 
ausgeregelt.

9. Ändern Sie den Wert in der Spalte „Constant“ wieder auf „0“ 
(danach <Return> drücken).

Die Leerlaufdrehzahl zeigt das gewohnte Verhalten und wird 
wieder ausgeregelt.

10.Setzen Sie „Mode“ für den nachfolgenden Betrieb mit Hard-
ware wieder auf „MODEL“.

Spannungsquelle an ADC-Modul anschließen
1. Schließen Sie an den Eingangskanal 0 eine regelbare Span-

nungsquelle (0 - max. 10 V) an. Die Belegung des Frontste-
ckers finden Sie im „PB1651ADC1 A/D Module - 
Benutzerhandbuch“.

Experiment starten
1. Stellen Sie sicher, dass das bei der Projekterstellung angege-

bene Simulationstarget angeschlossen und eingeschaltet ist.

2. Wählen Sie Experiment → Download → LABCAR.

oder
- Klicken Sie den Pfeil neben dem Symbol Download und 

wählen Sie LABCAR.
Das Experiment wird zum Experimentaltarget heruntergela-
den. 

Wenn dies erfolgreich durchgeführt wurde, wird im Register 
„Messages“ eine Meldung ausgegeben.
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3. Wählen Sie Experiment → Start Simulation → LABCAR.

oder
- Klicken Sie den Pfeil neben dem Symbol Start Simulation 

und wählen Sie LABCAR.
Das Experiment wird gestartet. 

Solange die angelegte Spannung unter der vorher definierten 
Schwelle liegt, ist das Signal „AirConditionManual“ gleich 0, die 
Leerlaufdrehzahl hat den Vorgabewert 750 U/min.

In der Signal List wird ebenfalls der Wert „0“ angezeigt. 

4. Verändern Sie nun die Spannung so, dass Sie die Komparator-
schwelle von 5,0 V übersteigt.

Die Klimaanlage wird eingeschaltet („AirConditionManual“ = 1), 
die Leerlaufdrehzahl bricht aufgrund des zusätzlichen Momen-
tes kurz ein und wird wieder ausgeregelt.

5. Senken Sie die Spannung wieder unter die Komparator-
schwelle von 5,0 V.

Nach einem Überschwinger wird die Leerlaufdrehzahl wieder 
eingeregelt.

6. Halten Sie das Experiment durch Klicken des Symbols Stop 
Simulation an.

oder
- Wählen Sie Experiment → Stop Simulation → LABCAR.

4.9 Aufzeichnen mit dem Datalogger
In diesem Abschnitt finden Sie eine Anleitung, wie Sie Signale mit dem Datalog-
ger aufzeichnen.

Um das An- und Ausschalten der Klimaanlage mit dem Datalogger aufzuzeich-
nen, gehen Sie wie folgt vor:
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Einen Datalogger erstellen
1. Wählen Sie im Arbeitsbereich von ETAS EE das Register „Data-

logger“.

2. Klicken Sie Add im Feld „Available Dataloggers“.

Ein neuer Datalogger wird hinzugefügt

Den Datalogger konfigurieren
1. Um ein Signal aus der Element List zum Datalogger hinzuzufü-

gen, wählen Sie die Messgröße „Out“ (siehe Bild).
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2. Drücken Sie die linke Maustaste und ziehen Sie das Element in 
den Bereich „Signals to record“.

Das Signal wird in die Liste der aufzuzeichnenden Signale auf-
genommen.

3. Fügen Sie ebenfalls den Modelleingang „AirConditionManual“ 
zum Datalogger hinzu. 

4. Wählen Sie eine Task aus, in deren Raster der Datalogger auf-
zeichnen soll (hier „Acquisition“).

Datei für die aufgezeichneten Daten wählen
Der „Basisname“ für die Datei, in der die aufgezeichneten 
Daten gespeichert werden, ist im Feld „Recording File Settings“ 
unter „Recording Base filename“ angegeben.

1. Um eine andere Basisdatei zu wählen, klicken Sie ....

Der Name nach jeder Aufzeichnung angelegten Datei wird 
durch die unter „Auto Increment“ gewählten Optionen 
bestimmt.

Die Auswahl der Option „Auto Increment“ führt dazu, dass der 
Dateiname um eine Nummer erweitert wird, die bei jedem Start 
des Dataloggers automatisch hochgezählt wird. Die Zahl der 
Stellen dieser Nummer legen Sie im Feld „Digits“ fest.
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Datalogger manuell starten
1. Starten Sie die Simulation.

2. Aktivieren Sie den Datalogger (in der Spalte „Active“).

3. Zum Starten des Dataloggers klicken Sie auf die blaue Pfeil-
spitze.

Der Datalogger wird gestartet.

4. Zum Anhalten des Dataloggers klicken Sie auf das blaue 
Rechteck.

Der Datalogger wird angehalten und die Daten in einer Datei 
(*.dat) gespeichert.

Triggerbedingungen und Aufzeichnungsdauer festlegen
Wenn Sie einen automatischen Start (bzw. Ende) der Aufzeichnung wünschen, 
müssen Sie eine Triggerbedingung festlegen.

INFO
Der Datalogger kann nur bei laufender Simulation aktiviert
werden!
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1. Klicken Sie das Symbol ... rechts unten im Feld „Trigger Set-
tings“.

Der Editor für die Triggereinstellungen wird geöffnet.

2. Unter „Filter Type“, wählen Sie „Start Trigger Filter“

3. Wählen Sie unter „Trigger Condition“ folgende Einstellungen:

- First Operand (Signal): „AirConditionManual“
- Operator: >
- Threshold: 0,5

4. Wählen Sie unter „Trigger Timing“ folgende Einstellungen:

- Pre Trigger Time: 0 s
- Post Trigger Time: 10 s

5. Klicken Sie OK.
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6. Aktivieren Sie den Datalogger (in der Spalte „Active“).

7. Schalten Sie nun mit Ihrer Spannungsquelle die Klimaanlage 
an.

Der Datalogger beginnt nach Eintritt der Triggerbedingung mit 
der Aufzeichung der Daten, die nach 10 s wieder endet.
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5 ETAS Network Manager
Der ETAS Network Manager wird für die Erstellung einer Konfiguration einge-
setzt, die vom ETAS IP Manager für die dynamische IP-Adressierung der ETAS-
Hardware in Ihrem Netzwerk (ETAS-Netzwerk) verwendet wird.

5.1 Übersicht
ETAS-Software unterstützt verschiedene Konfigurationen für den Hardware-
Zugang über Ethernet:

• Verwendung mehrerer Netzwerkadapter:

– ein Netzwerkadapter für das Firmen-Netzwerk und
– ein oder mehrere Netzwerkadapter für die ETAS-Hardware oder

• Verwendung eines Netzwerkadapters:

– automatisches Umschalten zwischen Firmen-Netzwerk und der 
ETAS-Hardware. 

Bei der Auswahl des Netzwerkadapters für die ETAS-Hardware werden Sie vom 
ETAS Network Manager unterstützt.

Der ETAS Network Manager gibt Ihnen einen Überblick über die verfügbaren 
Netzwerkadapter Ihres PCs sowie der Art der IP-Adress-Zuweisung. Ist mehr 
als ein Netzwerkadapter im System vorhanden, können Sie hier den Netzwerk-
adapter auswählen, mit der Sie die ETAS-Hardware an Ihren PC anschließen. 
Außerdem können Sie den Adressbereich für die IP-Zuweisung der ETAS-Hard-
ware festlegen.

Für die Auswahl des Netzwerkadapters und die Konfiguration der Netzwerk-
umgebung für die ETAS-Hardware benötigen Sie keine Administratorrechte. Sie 
können zwischen dem ETAS-Netzwerk und dem Firmen-Netzwerk wechseln, 
ohne den PC neu zu starten.

INFO
Sie benötigen keinen separaten Netzwerkadapter, um die ETAS-Hardware an
Ihren PC anzuschließen. Sie können ein und denselben Netzwerkadapter
sowohl für das Firmen-Netzwerk als auch für das ETAS-Netzwerk verwen-
den. 

INFO
Mit dem Network Manager können Sie keine Konfiguration oder Konfigurati-
onsänderung des Netzwerkadapters durchführen. Ändern Sie die Netzwerk-
einstellungen Ihres PC stattdessen über die Systemsteuerung (siehe
Dokumentation Ihres verwendeten Betriebssystems).
Hierfür sind Administratorrechte erforderlich.
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5.2 ETAS-Hardware-Adressierung
Über das ETAS-Netzwerk können Sie mehrere Geräte (auch gleichen Typs) an 
Ihren PC anschließen. Die angeschlossenen Geräte werden im lokalen ETAS-
Netzwerk durch ihre einmalige IP-Adresse identifiziert.

Ein in die ETAS-Software integrierter IP-Manager vergibt die IP-Adressen aus 
einem Adressen-Pool an die angeschlossenen Geräte.

Den Adressbereich des Adressen-Pools können Sie im Network Manager fest-
legen.

5.3 Netzwerkadapter-Adressierung

5.3.1 Art der Netzwerkadapter-Adressierung
Die Art der Netzwerkadapter-Adressierung im Firmen-Netzwerk ist vom ver-
wendeten Betriebssystem und der Konfiguration des Netzwerkadapters abhän-
gig:

Das ETAS-Netzwerk unterstützt folgende Netzwerkadapter-Adressierungen:

Wollen Sie die Netzwerkadapter sowohl für das Firmen-Netzwerk als auch für 
das ETAS-Netzwerk verwenden, können Sie die Netzwerkadapter, die aus-
schließlich die Adressierung DHCP unterstützen, nicht für den Doppelbetrieb 
verwenden. 

Betriebssys-
tem

Art der Netzwerkadapter-Adressierung

manuell DHCP DHCP+APIPA DHCP+
alternative IP-
Adresse

Windows 7 ja ja ja ja
Windows 10 ja ja ja ja

Betriebssys-
tem

Art der Netzwerkadapter-Adressierung

manuell DHCP DHCP+APIPA DHCP+
alternative IP-
Adresse

Windows 7 ja nein ja ja
Windows 10 ja nein ja ja

INFO
DHCP kann nur in Kombination mit APIPA oder alternativer IP-Adresse ver-
wendet werden!
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5.3.2 Manuelle Adressierung der Netzwerkadapter
Das Adressieren eines Netzwerkadapters ist abhängig vom Betriebssystem.

Die Anleitung für die Adressierung des Netzwerkadapters Ihres PCs können Sie 
der Dokumentation Ihres Betriebssystems entnehmen.

Um den Netzwerkadapter manuell zu adressieren, benötigen Sie Administrator-
rechte. Wenden Sie sich gegebenenfalls an Ihren Systemadministrator.

Ist der Netzwerkadapter manuell adressiert, d.h., besitzt er eine statische IP-
Adresse, kann der Fall eintreten, dass Sie versehentlich nach ETAS-Hardware 
suchen oder ETAS-Hardware initialisieren wollen, obwohl der PC mit dem Fir-
men-Netzwerk verbunden ist. Sie können im Network Manager festlegen, dass 
für diesen Fall eine Warnung angezeigt wird, bevor eine IP-Adresse an eine 
ETAS-Hardware vergeben wird.

5.3.3 Adressierung des Netzwerkadapters über DHCP
Die Adressierung über DHCP setzt voraus, dass der DHCP-Server verfügbar ist. 
Sollte der DHCP-Server nicht verfügbar sein oder gibt es keinen DHCP-Server 
(wie im ETAS-Netzwerk), ist der Netzwerkadapter nicht konfiguriert.

Für diesen Fall hat jedes Betriebssystem einen Automatismus, damit der Netz-
werkadapter automatisch eine IP-Adresse erhält:

Windows XP / Windows Vista/ Windows 7
Windows XP, Windows Vista und Windows 7 prüfen automatisch, ob eine Ver-
bindung zum DHCP-Server besteht. Ist dies nicht der Fall, so wird die IP-
Adresse automatisch entweder über APIPA vergeben oder es wird die benut-
zerspezifische alternative IP-Adresse verwendet. Im ETAS-Netzwerk wird 
immer entweder die APIPA-Adresse oder die alternative IP-Adresse verwendet. 

Beim Umstecken zwischen DHCP-Netz und ETAS-Hardware sollte darauf 
geachtet werden, dass ein Verbindungsausfall durch das Betriebssystem 
detektiert wird, da nur dann eine Umkonfiguration angestossen wird. Dies dau-
ert bis zu 10 Sekunden. Für die eigentlich Umkonfiguration von einer DHCP-
Adresse auf eine APIPA oder die alternative benötigt das Betriebssystem 60 
Sekunden. Wird der Netzwerkadapter wieder an das DHCP-Netz angeschlos-
sen findet die Konfiguration auf eine DHCP-Adresse unmittelbar nach Verbin-
dungsdetektion statt.

Eine Netzwerkadapter-Adressierung über DHCP ohne alternative Adressierung 
wird nicht unterstützt.
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5.4 Bedienoberfläche

5.4.1 Konfigurationsfenster 1 — Auswahl eines Netzwerkadap-
ters
(„Netzwerkeinstellungen für ETAS Hardware (Seite 1)“)

Folgende Informationen über die verfügbaren Netzwerkadapter werden ange-
zeigt:

• Kontrollkästchen Automatischer IP-Adressbereich 

Wenn Sie dieses Kontrollkästchen aktivieren, wird der nächste Konfigu-
rationsschritt übersprungen, und der ETAS Network Manager weist 
automatisch IP-Adressbereiche für die Adressierung der ETAS-Hard-
ware durch den ausgewählten Netzwerkadapter zu. Falls der IP-Adress-
bereich durch den IP-Manager automatisch geändert wird, wird im 
Infobereich der Windows-Taskleiste eine entsprechende Meldung ange-
zeigt.

• Kontrollkästchen Automatische Konfiguration des ETAS-Netzwerks 

Durch Aktivierung dieses Kontrollkästchens können Sie mehrere Netz-
werkadapter gleichzeitig für die automatische Konfiguration durch den 
IP-Manager aktivieren oder deaktivieren.
Wenn Sie dieses Kontrollkästchen aktivieren, wird das Kontrollkästchen 
„Automatischer IP-Adressbereich“ aktiviert. In der Liste der verfügbaren 
Netzwerkadapter wird die Spalte „Aktiv für ETAS-Netzwerk“ eingefügt. 
Dort können Sie festlegen, welche Netzwerkadapter für die automati-
sche Konfiguration durch den IP-Manager zur Verfügung stehen sollen.
Beginnend mit dem ausgewählten Netzwerkadapter geht der ETAS Net-
work Manager von oben nach unten durch die Liste, verwendet den ers-
ten Adapter mit einer für ETAS gültigen1 IP-Konfiguration und 
konfiguriert den IP-Adressbereich automatisch. Kann ein konfigurierter 
Netzwerkadapter nicht verwendet werden, z.B. weil er deaktiviert wurde 
oder physikalisch nicht verfügbar ist, konfiguriert der IP-Manager auto-
matisch den nächsten verfügbaren Netzwerkadapter. Im Infobereich der 
Windows-Taskleiste wird eine Meldung mit der Angabe der neuen Konfi-
guration angezeigt. 

1. Eine IP-Konfiguration ist gültig, wenn der Netzwerkadapter entweder eine feste 
IP-Adresse verwendet oder wenn DHCP und APIPA aktiviert sind.
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• Spalte Aktiv für ETAS-Netzwerk

Diese Spalte ist nur sichtbar, wenn das Kontrollkästchen „Automatische 
Konfiguration des ETAS-Netzwerks“ aktiviert ist. Mit dem Kontrollkäst-
chen in dieser Spalte können Sie festlegen, welche Netzwerkadapter für 
die automatische Konfiguration durch den ETAS Network Manager ver-
fügbar sein sollen (siehe „Automatische Konfiguration von Netzwerkad-
aptern für ETAS-Hardware“ auf Seite 77)

• Spalte Name 

Name des Netzwerkadapters. Der Eintrag ist in diesem Fenster nicht edi-
tierbar.
Diese Spalte enthält auch den Eintrag “Kein Adapter”. Wenn Sie den IP-
Manager deaktivieren möchten, z.B. weil keine Ethernet-Hardware mit 
dem PC verbunden ist, können Sie diesen Eintrag in der Spalte “Aktiv für 
ETAS-Netzwerk” aktivieren.

• Spalte IP Adresse 

IP-Adresse des Netzwerkadapters. Der Eintrag ist in diesem Fenster 
nicht editierbar.

• Spalte Subnetzmaske 

Einstellung für die Subnetzmaske. Der Eintrag ist in diesem Fenster nicht 
editierbar.

• Spalte DHCP 

Zeigt an, ob der Netzwerkadapter für DHCP konfiguriert ist:
– Enabled

Der Netzwerkadapter ist für DHCP konfiguriert.
– Disabled

Der Netzwerkadapter ist mit einer festen IP-Adresse konfiguriert.
• Spalte Ersatz IP-Konfiguration

Zeigt die alternative IP-Adressierung des Netzwerkadapters, wenn dieser 
für DHCP konfiguriert ist. Die Anzeige ist abhängig vom verwendeten 
Betriebssystem.
– APIPA

Automatic Private IP Addressing: Verfahren zur Automatisierung der 
IP-Konfiguration von Netzwerkverbindungen

– ---
Eine alternative IP-Adresse ist nicht vorhanden.

– User Defined
Eine benutzerspezifische alternative IP-Adresse kann vom Anwender 
definiert werden (Windows XP / Windows Vista).
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5.4.2 Konfigurationsfenster 2 — Adressenpool festlegen
(„Netzwerkeinstellungen für ETAS Hardware (Seite 2)“)

Grundsätzlich lassen sich die Werte durch direktes Editieren bzw. durch das 
Setzen auf die Standardeinstellung über ein Dialogfenster verändern.

Folgende Netzwerkparameter können eingestellt werden:

• Startadresse 

Erste IP-Adresse des IP-Adressbereichs der ETAS-Hardware
• Stoppaddress 

Letzte IP-Adresse des IP-Adressbereichs der ETAS-Hardware
• Subnetzmaske 

Zugehörige Subnetzmaske

Reservierung von IP-Adressen
Im bisher für ETAS-Hardware benutzten IP-Adressbereich (192.168.40.1 - 
192.168.40.254 mit der Subnet Mask 255.255.255.0) sind die folgenden IP-
Adressen für bestimmte ETAS-Hardware reserviert:

Diese Adressen werden ausschließlich an diese Geräte vergeben und können 
somit nicht für andere ETAS-Hardware verwendet werden. Das ist bei der Defi-
nition des Adresspools unbedingt zu berücksichtigen.

IP_Adresse ETAS-Hardware
192.168.40.10 ES1120
192.168.40.11 ES1130
192.168.40.12 ES780
192.168.40.13 reserviert
192.168.40.14 ETAS Real-Time PC
192.168.40.15 ES1135
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5.4.3 Konfigurationsfenster 4 — Warnung anzeigen
(„Netzwerkeinstellungen für ETAS Hardware (Seite 4)“)
Dieses Dialogfenster wird Ihnen nur angezeigt, wenn der ausgewählte 
Netzwerkadapter manuell adressiert ist.

Folgende Parameter können eingestellt werden:

• Warnung anzeigen, bevor IP-Zuordnung ausgeführt wird 

Mit dem Kontrollkästchen wird festgelegt, dass eine Warnung angezeigt 
wird, bevor eine IP-Adresse an ETAS-Hardware zugewiesen wird.

INFO
Die Aktivierung dieser Warnung ist nur sinnvoll, wenn über diesen
Netzwerkadapter wahlweise der PC an einem Firmennetzwerk oder
ETAS-Messmodule im ETAS-Netzwerk betrieben werden sollen.
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5.5 Netzwerkadressen für ETAS-Hardware konfigurieren

5.5.1 Netzwerkadapter manuell konfigurieren
Netzwerkadapter für ETAS-Hardware konfigurieren:

1. Gehen Sie im Windows-Startmenü in den Programmordner 
Ihrer ETAS-Software (unter Start → Programme → ETAS) 
und wählen Sie dort den Eintrag ETAS Network Settings. 

Das Dialogfenster „Netzwerkeinstellungen für ETAS Hardware 
(Seite 1)“ wird geöffnet.

2. Wählen Sie im Feld „Verfügbare Netzwerkadapter“ den Netz-
werkadapter aus, die Sie für das Firmen- und das ETAS-Netz-
werk verwenden wollen. Wenn kein Netzwerkadapter auf 
ihrem PC installiert ist, enthält das Dialogfenster keine Ein-
träge.

INFO
Die Art der Adressierung des Netzwerkadapters muss vom
ETAS-Netzwerk unterstützt werden. Ist dies nicht der Fall,
können sie den Netzwerkadapter nicht auswählen.
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3. Klicken Sie Weiter.

Das Dialogfenster „Netzwerkeinstellungen für ETAS Hardware 
(Seite 2)“ wird geöffnet.

4. Geben Sie den IP-Adressbereich für die ETAS-Hardware und 
die Subnetzmaske ein oder klicken Sie Standard, damit der 
Netzwerkmanager den IP-Adressbereich und die Subnetz-
maske automatisch einträgt.

Sie können diese Einstellungen übernehmen oder überschrei-
ben.

5. Klicken Sie Weiter.

Das Dialogfenster „Netzwerkeinstellungen für ETAS Hardware 
(Seite 4)“ wird geöffnet.

6. Falls Sie festlegen möchten, dass eine Warnung angezeigt 
wird, bevor der ETAS-Hardware eine IP-Adresse zugewiesen 
wird, aktivieren Sie “Warnung anzeigen, bevor IP-Zuordnung 
ausgeführt wird”, 

INFO
Die Aktivierung dieser Warnung ist nur sinnvoll, wenn über
diesen Netzwerkadapter wahlweise der PC an einem Firmen-
netzwerk oder ETAS-Messmodule im ETAS-Netzwerk betrie-
ben werden sollen.
LABCAR-OPERATOR V5.4.13 - Schnelleinstieg 76



ETAS ETAS Network Manager
7. Klicken Sie Fertigstellen.

8. Starten Sie die ETAS-Software neu, damit die Änderungen 
übernommen werden. Der Neustart ist nicht erforderlich, wenn 
der Konfigurator automatisch seitens der ETAS-Software bei 
einer Hardwaresuche oder Initialisierung aufgerufen wurde.

5.5.2 Automatische Konfiguration von Netzwerkadaptern für 
ETAS-Hardware
Der ETAS Network Manager bietet die Möglichkeit zur automatischen Zuwei-
sung von IP-Adressbereichen im ETAS-Netzwerk durch den IP-Manager. Sie 
können entweder die automatische Konfiguration eines ausgewählten Netz-
werkadapters durch den IP-Manager vornehmen lassen oder, falls mehrere 
Netzwerkadapter verfügbar sind, die automatische Konfiguration des ETAS-
Netzwerks einschließlich Auswahl des zu verwendenden Adapters veranlas-
sen.

Ausgewählten Netzwerkadapter für ETAS-Hardware automatisch konfigurie-
ren

1. Gehen Sie im Windows-Startmenü in den Pro-grammordner 
Ihrer ETAS-Software (unter Start → Programme → ETAS) 
und wählen Sie dort den Eintrag ETAS Network Settings.

Das Dialogfenster „Netzwerkeinstellungen für ETAS Hardware 
(Seite 1)“ wird geöffnet.

2. Wählen Sie im Feld „Verfügbare Netzwerkadapter“ des Dialog-
fensters „Netzwerkeinstellungen für ETAS Hardware (Seite 1)“ 
den Netzwerkadapter aus, den Sie für das Firmen- und das 
ETAS-Netzwerk verwenden wollen. Wenn kein Netzwerkadap-
ter auf ihrem PC installiert ist, enthält das Dialogfenster eine 
Einträge.

3. Aktivieren sie das Kontrollkästchen „Auto IP-Adressbereich”.

INFO
Die Art der Adressierung des Netzwerkadapters muss vom
ETAS-Netzwerk unterstützt werden. Ist dies nicht der Fall,
können sie den Netzwerkadapter nicht auswählen.
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4. Klicken Sie Fertigstellen.

Der ETAS-Netzwerkmanager legt automatisch Standardad-
ressbereiche fest, die von dem ausgewählten Netzwerkadap-
ter zur Adressierung der ETAS-Hardware verwendet werden.

Wenn der IP-Manager zu einem späteren Zeitpunkt den IP-Adressbereich auto-
matisch ändert, wird eine Nachricht im Infobereich angezeigt.

Einen Netzwerkadapter unter mehreren verfügbaren Netzwerkadaptern auto-
matisch konfigurieren

1. Gehen Sie im Windows-Startmenü in den Pro-grammordner 
Ihrer ETAS-Software (unter Start → Programme → ETAS) 
und wählen Sie dort den Eintrag ETAS Network Settings.

Das Dialogfenster „Netzwerkeinstellungen für ETAS Hardware 
(Seite 1)“ wird geöffnet.

2. Aktivieren Sie das Kontrollkästchen „Automatische Konfigura-
tion des ETAS-Netzwerks” im Dialogfenster „Netzwerkeinstel-
lungen für ETAS Hardware (Seite 1)“

Das Kontrollkästchen „Auto IP-Adressbereich” wird aktiviert 
und in der Liste der verfügbaren Netzwerkadapter wird die 
Spalte “Aktiv für ETAS-Netzwerk eingefügt.

3. Aktivieren Sie alle Netzwerkadapter, die für eine automatische 
Konfiguration des IP-Managers verfügbar sein sollen, indem 
sie das entsprechende Kontrollkästchen der Spalte „Aktiv für 
ETAS-Netzwerk” aktivieren.

4. Klicken Sie Fertigstellen.

Beginnend mit dem ausgewählten Netzwerkadapter geht der ETAS Network 
Manager von oben nach unten durch die Liste, verwendet den ersten Adapter 
mit einer für ETAS gültigen1 IP-Konfiguration und konfiguriert den IP-Adressbe-
reich automatisch. Kann ein konfigurierter Netzwerkadapter nicht verwendet 
werden, z.B. weil er deaktiviert wurde oder physikalisch nicht verfügbar ist, kon-
figuriert der IP-Manager automatisch den nächsten verfügbaren Netzwerkad-
apter. Im Infobereich der Windows-Taskleiste wird eine Meldung mit der 
Angabe der neuen Konfiguration angezeigt.

1. Eine IP-Konfiguration ist gültig, wenn der Netzwerkadapter entweder eine feste 
IP-Adresse verwendet oder wenn DHCP und APIPA aktiviert sind.
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5.5.3 APIPA in der Registrierung aktivieren

APIPA in der Registrierung aktivieren
1. Klicken Sie Start und anschließend Ausführen.

2. Geben Sie regedit ein und klicken Sie OK.

Der Registrierungs-Editor öffnet sich.

3. Klicken Sie auf den Eintrag eines Netzwerkadapters im Regist-
rierungsschlüssel:

Globaler Schlüssel (für alle Netzwerkadapter)

HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\
Services\Tcpip\Parameters
Schnittstellen- oder kartenspezifischer Schlüssel

HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\
Services\Tcpip\Parameters\
Interfaces\adapter_name

4. Setzen Sie den Wert für IPAutoconfigurationEnabled 
auf 1. Der APIPA-Mechanismus ist aktiviert.

INFO
Sie benötigen Administratorrechte, um Änderungen in der Registrierung vor-
zunehmen.

INFO
Wenn keiner dieser Schlüssel existiert, ist der APIPA-Mecha-
nismus deaktiviert. Existiert der globale Schlüssel, ist aber
nicht aktiviert, ist der globale Schlüssel ausschlaggebend.
Existiert der globale Schlüssel nicht oder ist er aktiviert, ist
der kartenspezifische Schlüssel ausschlaggebend.
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6 Kontaktinformationen

ETAS Hauptsitz
ETAS GmbH

ETAS Regionalgesellschaften und Technischer Support
Informationen zu Ihrem lokalen Vertrieb und zu Ihrem lokalen Technischen 
Support bzw. den Produkt-Hotlines finden Sie im Internet:

Borsigstraße 24 Telefon: +49 711 3423-0
70469 Stuttgart Fax: +49 711 3423-2106
Deutschland Internet: www.etas.com

ETAS Regionalgesellschaften Internet: www.etas.com/de/contact.php
ETAS Technischer Support Internet: www.etas.com/de/hotlines.php

https://www.etas.com
https://www.etas.com/de/contact.php
https://www.etas.com/de/hotlines.php
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